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SP Max™ User's Guide 
Copyright © 1999 Elcomponent Ltd 

All Rights Reserved. 

The information in this document is subject to change without notice.  

Elcomponent Ltd has made every effort to ensure the accuracy of this manual.  
However, Elcomponent Ltd makes no warranties with respect to this documentation 
and disclaims any implied warranties of merchantability and fitness for a particular 
purpose.  Elcomponent Ltd assumes no responsibility for any errors that may appear 
in this document. 
Trademarks 

IBM is a registered trademark of International Business Machines Corporation. 

Windows, Windows 95 and Windows 98 are trademarks of Microsoft Corporation. 

Lotus is a trademark of Lotus Development Corporation. 

All other product names are copyright and may be trademarks and/or registered 
trademarks of their respective companies. 

 

Symbols: 

The following symbols may be used in this manual 

 

WARNING: Failure to follow the instructions may result in personal injury or 
damage to the instrument. 

 

NOTE: Failure to follow the instructions may result in an instrument or 
software malfunction. Λ 
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Introduction to SP Max 
The SP Max  has been developed by Elcomponent to provide the energy 
manager with a safe, easy and accurate method of obtaining load profiles, 
consumption data and power factor profiles on both three phase and single 
phase systems.  The unit is designed to be used in conjunction with SP 
PowerPack software, and includes the following features: 
• True RMS measurement 
• ± 0.25% accuracy on primary parameters 
• Safe voltage connection via standard wall socket 
• Strong weatherproof case 
• Pulse input channel for external meter verification 
• 512kb memory 
• Foolproof ‘two button’ operation 
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Hardware Specifications 
Maximum Channels 
6 Selectable storage for each channel 
Range 
Ch 1 
Ch 2 
Ch 3 
Ch 4 
Ch 5 
Ch 6 

0 - 275 VAC RMS for 50/60 Hz operation. 
0 - 1 VAC - Current CT Input 
0 - 1 VAC - Current CT Input 
0 - 1 VAC - Current CT Input 
0 - 360° Ch 1 to Ch 2 – Power Factor calculated via software. 
Pulse input – Pulse input for dry or voltage free contacts only. 
 

External Connections 
1 voltage/auxiliary power, 1 download, 3 current,  1 pulse 
Sensor Type 
External CTs, internal impedance network for voltage 
Sampling Rate 
0.25 second  
Data Storage Rate 
1 second to 15 minutes Set via software 
Parameters Stored 
Avg, Min/Max, or Min/Max/Avg Set via software 
Samples per Average 
4 - 3600, depending on storage rate. Set automatically 
Memory 
512K, non-volatile RAM  
Memory Treatment 
Stop when full, or wrap. Set via software 
Storage Capacity 
15 days for 6 channels, 
Min/Max/Avg, 1 min. storage interval 

Capacity depends on number of 
channels used and storage mode 

Status  Indicators 
Line Power, Over/Under Voltage, Phase Error/Over Current/No Current, 
Recording, Battery Charged (inside cover) 
Power 
Line Power, Internal battery Battery recharged via line power 
Battery Life 
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14 days  
Communications 
Opto-isolated RS232, support for remote set-up 
Software 
SP PowerPack Requires PC running Windows 3.1 

or later and 1 free serial port 
Packaging 
Rugged, durable ABS.  
Accuracy 
± 0.25 % Range + CT error  
Safety 
Optically isolated download  
Operating Temperature 
- 20ºC to 50ºC  

Specifications subject to change without notice. 

Important Safety Information 

WARNING: SP Max has been designed for safety in use. However, 
individuals using the logger must be suitably qualified and trained, and are 
responsible for the safe operation of the logger. Please observe the 
following safety precautions: 

• Do not allow water seepage into the logger. The logger case is not 
hermetically sealed and moisture can cause a shock hazard to the operator 
and damage to the unit. 

• Never work alone with live voltage. 

• When installing the logger near live voltage, connect the unit only after the 
power has been turned off. 

• To avoid personal injury and damage to the logger, never exceed the 
maximum rated input voltage for a channel.  
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The Logger - Inside Front Cover 

Status Indicators 
There are 5 status indicators on the front of the unit. These lights may be on, 
off or flashing to indicate different conditions. 
1 - Battery Charged Indicator 
This indicator is live only when mains power is connected. 
ON =  Fully Charged 
OFF =  Discharged 
FLASHING =  Charging 
 

NOTE: Under certain charge conditions the led may flash in an 
irregular fashion.  This does not indicate a malfunction. 

 
2 - Line Power Indicator 
When the Line Power light is ON it indicates that the logger is operating on 
line power. The light is OFF when the logger is operating on battery power. 

Status 
Indicators 

Sleep 
Button 

9 pin RS232 
serial port 
connection 

RESET 
button

Recording Light 

Λ 
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3 - Under Voltage/Over Voltage/Phase Error Indicator 
Using SP PowerPack, you can set voltage alarm levels in the logger. If SP 
Max detects a voltage outside this range at any time during a survey, the 
Under Voltage/ Over Voltage light is turned ON. The light FLASHES to 
indicate that the voltage and Channel 1 current are out of phase (see page 8). 
Resetting the logger clears the memory and turns off the Under Voltage/ Over 
Voltage light. 
 
4 - Over Current Indicator 
Using SP PowerPack, you can set an overcurrent alarm level range in the 
logger. If SP Max detects a current above this range at any time during a 
survey, the Over Current light is turned ON. The light FLASHES to indicate 
that the current has fallen below the specified range and that the power factor 
calculation has been discontinued. If the light is OFF, no over or under current 
event has been detected. Resetting the logger clears the memory and turns 
off the Over Current light. 
 
Recording Indicator 
The Recording light blinks while SP Max is logging. 
Sleep Button 
The Sleep button is a recessed control. Press the Sleep button before 
disconnecting or transporting SP Max to stop the logging function and power 
down the logger to standby mode. This minimises the risk of data loss and 
prevents the logger from recording zero values after it has been 
disconnected. 
Reset Button 
The RESET button is a recessed control. Press RESET after transporting the 
logger to the survey site and connecting it. Resetting clears the logger's 
memory, clears the Under Voltage/Over Voltage and Over Current event 
detection lights, and begins a new survey.  

NOTE: Because resetting clears the logger's memory, make sure 
to download any logged data before pressing RESET.  To carry 
out a reset, the button must be depressed for at least 3 seconds. 

 
Purge Valve Knob 
The SP Max case includes a purge valve, however it is not functional. The 
logger cannot be hermetically sealed. To avoid a shock hazard to the operator 
and damage to the unit do not allow water seepage into the logger.  
 

Λ 
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Serial Port Connection 
The communication cable supplied with SP Max connects at this 9 pin RS232 
connector.   
 

NOTE: Be sure to use the cable supplied with the logger when 
connecting to a PC 

 

The Logger - Connectors  

 

 

 

The connections to the logger are located on the side of the unit.  
Voltage 

The voltage input connector is a standard IEE type and is normally connected 
to a standard 230V wall socket with the cable supplied.  A ‘croc clip’ 
accessory cable is also available. 

WARNING: If the ‘croc clip’ is used the connected voltage must 
not exceed 250VAC.  On three phase systems the connection 
must be made between phase and neutral.  Connecting the 
voltage input phase to phase will damage the logger and could 
be hazardous.   

Current 

The three current input connectors are for Current Transformer (CT) 
connection only, and are normally used with the CTs provided in the SP MAX 
kit.  Other suitable CTs are available as  accessories 

WARNING: The inputs are designed for connection to CTs with a 
maximum output of 1VAC.  Connection to other types of CT will 
damage the logger and could be hazardous. 

Pulse meter 
logging 

connection 

Line power 
connection 
and voltage 

logging 

Connections for 
current logging 

- 3 channels 
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Three inputs are provided, and may be used either as the three phases of a 
three phase system, or as separate channels of multiple single phase loads. 
 
Pulse 

The pulse input connection is designed for connection to an external volt-free 
contact.  The necessary power for the current loop is provided by the logger. 

WARNING: Do not connect the pulse input to a power supply.  This 
will damage the logger and could be hazardous. 

A pulse input cable is supplied in the standard SP Max kit. 

 

The Logger - Connection Information 

The SP Max has been designed to make connection as quick, easy and safe 
as it can be. 

It’s QUICK  because there is a minimum number of connections to make. 

It’s EASY because the led indicators clearly show a ‘go/no go’ situation. 

It’s SAFE because the only connection required is made to a standard 
13A wall socket, avoiding the need for live conductors to be 
exposed. 

NOTE: Before connecting the SP Max to a supply please read the 
instructions relating to the SP PowerPack software and instrument 
set up. 

Once you have programmed the logger for your desired survey, connecting it 
to the supply is carried out as follows: 

Λ 
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SINGLE PHASE 

Connection using Wall Socket 

 

 

 

 

 

 

 

 

 

Connection using ‘Croc Clip’ Voltage Lead 

 

 

1.    Press and hold reset button to enable the Logger. 

 NOTE: This will clear any data in the memory. 

2. Connect the mains cable to a convenient wall socket, or connect the croc 
clip/lead as shown in the above diagram. 

3. Connect a CT to Channel 1 input.  Place the CT around the LIVE cable of 
the load to be monitored.  Ensure that the arrow on the CT is pointing 
towards the load. 

4. Check that led 2(green) is on to indicate live voltage is present, and that 
led 3 (red) is off indicating the CT orientation is correct.   If led 3 is 
flashing, simply reverse the direction of the CT on the cable. 

Λ 

Voltage Input

CT Ch 1 

Voltage  
Input 
CT  
Ch 1 
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NOTE: if led 4 (red) is flashing, it is not possible for the instrument 
to detect the CT orientation.  Ensure that the minimum current 
trigger is set at a level below the level of current actually flowing 
(see page 8) 

NOTE: If leds 3&4 are permanently on, a trigger condition has been 
detected, but this does not affect the operation of the data logging. 

 

THREE PHASE 

 

 

 

 

Connection using wall socket 

 

 

 

 

Connection 
using ‘croc clip’ 

voltage lead 

 

WARNING: 
do not connect voltage input phase to phase 

Λ 

VOLTAGE 
INPUT 
CT CH 1 
CT CH 2 
CT CH3 

Λ 
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1. Press and hold reset button to enable the Logger. 

NOTE:This will clear any data in the memory 

2. Connect the mains cable to a convenient wall socket, or connect the croc 
clip as shown in the above diagram. 

3. Connect a CT to channel 1 input.  Place the CT around the red phase 
conductor ensuring that the arrow is facing towards the load. 

4. Check that led 2(green) is on to indicate live voltage is present, and that 
led3 (red) is off indicating the CT orientation is correct.  If led 3 is flashing, 
remove the CT from the red phase and place it on yellow (maintaining the 
same orientation of the arrow).  Repeat this procedure with the blue 
phase if the led continues to flash.  If the led continues to flash on all 
phases, the orientation of the CT is incorrect.  Reverse the direction of the 
arrow and repeat the above procedure until the led goes out. 

NOTE: if led 4 (red) is flashing, it is not possible for the instrument 
to detect the CT orientation.  Ensure that the minimum current 
trigger is set at a level below the level of current actually flowing 
(see page 8) 

NOTE: If leds 3&4 are permanently on, a trigger condition has been 
detected, but this does not affect the generation of the data logging. 

Once the first CT has been correctly connected, the remaining two CTs can 
be hooked up.  The position and orientation of these is not significant. 

When the SP Max has been correctly connected to the supply to be 
monitored, it is recommended that the instrument is reset, to clear the 
memory and restart data logging.  At this point it is useful to check the led 
status (see page 4-5) to ensure the unit is working correctly. 

Introduction to SP PowerPack Software 

The Silent Partner PowerPack software (SP PowerPack) is supplied in the 
standard SP Max kit, and is an essential part of the package.  It is used to: 

• Set up the logger 

• Set the logging parameters 

• Interrogate the logger (status report) 

• Download collected data 

• Display, manage and print downloaded data. 

• Calculate energy consumption and power data from primary 
measured values. 

Λ 

Λ 

Λ 
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SP PowerPack Software 
SP PowerPack is a Windows-based application so you will find the interface 
familiar. It employs the same menu structure and screen navigation as other 
Windows programs. Simply make selections using a mouse, or from the 
keyboard by pressing the underlined letter of the command you wish to select. 
Dimmed menu items are unavailable.  
For additional information on using Windows refer to your Windows 
documentation or on-line Help. 
 

Quick Start 

This section provides an overview to help you get started quickly. Please read 
through the remainder of this manual for important information on the correct 
set-up and use of the SP Max logger and SP PowerPack software. 
Preparing to Log 

1. Install SP PowerPack software. 

2. Start SP PowerPack software. 

3. Connect the SP Max logger at the PC serial port. 

4. Select the logger type and serial port, set the time and date, and specify 
the data logging parameters. 
(Set-up, Logger Serial Port), (Logger, Set Time and Date) 
(Logger, Change Parameters) 

5. Disconnect the logger from the PC. 

6. Connect the logger to the load you wish to monitor. 

7. RESET the logger to begin your survey. 

 
After Your Survey 

1. Disconnect the logger from the load and connect it to the PC. 

2. Start SP PowerPack and download the data. 
(Logger, Download SP Data) 

3. Set-up the Power, Costing or Pulse calculations. 
(Set-up, Range/Power), (Set-up, Range/Power), 
(Set-up, Pulse Rate Period)  

4. Select a display group. 
(Set-up, Measurement Scale) 
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5. Select a report type. 
(View, report type) 

6. Tailor the report's appearance to suit your needs. 
(Set-up, Display/Print Options) 

7. Print the report and save the file. 

 

Installing SP PowerPack Software 
System Requirements: 
• 486 or better (Pentium recommended) 
• Windows 3.1 or later (W95/98 recommended) 
• VGA display  
• COM1, 2, 3, or 4 (serial communications port) 
• Hard disk with 1 megabyte free 
• Floppy drive (for program installation) 
 
Software Installation 
1. Make sure that your computer is running Windows 3.1, 95 or 98. 
2. Insert the SP disk in the floppy drive (A: or B:). 
3. Windows 3.1 users, select Run from the File menu in the Program 

Manager to open the Run dialog box.  

Windows 95 or 98 users click  and select Run to open the Run 
dialog box. 

4. In the Run dialog box, type A:\SETUP (or B:\SETUP). 
5. Follow the on-screen instructions. 

A program group named SP and a SP PowerPack icon are created during 
installation. To run the program, double click the icon. 
After installing the software you will need to specify the type of logger you are 
using and the number of the serial port that you will use to communicate with 
the logger. In addition, you may wish to change the default directories in 
which SP stores data and export files. Turn to Setting Up SP PowerPack 
Software for instructions. 

Connecting the Logger to a PC 

1. Attach the power cord at the socket on the side of the logger. 

 NOTE: Not necessary if the battery is fully charged. Λ 
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2. Plug the power cord into an electrical outlet. The Line Power light will 
come on. 

3. Open the logger's front cover and plug the download cable into the 9 pin 
connector. 

4. Plug the other end of the download cable into a serial communication port 
on the back of the PC.  

The first time you communicate with a logger from a PC you will need to 
identify for the software which logger type and COM port you are using.  

 

Starting SP PowerPack Software 

1. Double click the SP icon to start the program and display the opening 
screen. 

 
After a few seconds the opening screen closes to display a blank screen 
with the SP PowerPack title bar and main menu at the top. 
 
 

Setting Up SP PowerPack Software 
After installing SP PowerPack, you must complete the set-up of the software. 
Elcomponent Ltd offers a broad range of Silent Partner loggers, all supported 
by SP PowerPack. The first time you communicate with your logger from a 
PC you will need to identify for the software which model of logger you are 
using. You will also need to specify which PC serial port will be used to 
communicate with the logger, and synchronise the logger's time and date with 
that of the PC. You may also wish to change the default directories that SP 
PowerPack uses to store data files and export files. 
Identifying the Logger and Serial Port 

1. Click Logger Serial Port in the Set-up menu to open the Logger Port 
Set-up dialog box. 

2. Scroll down the Select Logger Type list and click SP Max. 
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3. In the Select Serial Port for Logger list, click the COM port to which the 
logger is attached. 

 

If you do not know the COM port's number you can instruct SP to scan all 
the ports and locate the logger. To scan ports for the logger, proceed to 
Step 4. If you have already selected the COM port, go to Step 7. 

 
4. Click

 
Start Port Scan for Logger. SP PowerPack reminds you to 

connect the logger. 

 

5. Click OK. SP confirms the location of the logger. 

 

6. Click OK. SP selects the port at which the logger was found as the 
download port. 
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7. Click OK again to confirm the selection and close the Logger Port Set-up 
dialog box. 

 
Synchronising Logger Time and Date with the PC 
To ensure the accuracy of your surveys you will need to synchronise SP 
Max's internal clock with that of your PC before logging any data. You may 
also need to re-synchronise the clock if you use SP Max with a different PC, 
or after you have recharged the logger's battery. 

NOTE: Changing the time and date erases the logger's memory and 
resets the logger. Download any data before synchronising. 

NOTE: The accuracy of your data in respect of logging timer is only 
as good as the PC used to set up the SP Max.  If your PC clock 
wrongly set, all collected data will also be misreported in this 
respect. 

1. Make sure the logger is connected to the correct PC serial port. 
2. Click Set Time and Date in the Logger menu. SP PowerPack 

communicates with the logger and displays a warning. If you have logged 
data that you wish to save, click Cancel and turn to Downloading Data. 
Otherwise, proceed. 

 
3. Click OK. SP PowerPack synchronises the time and date in the logger 

with the time and date in the PC and displays a confirmation message. 

 
4. Click

 
OK to close the Logger Clock Time confirmation message. 

 
NOTE: SP PowerPack lets you synchronise the time and date. 
However the format in which time and date appear is determined by 
the selection you make in the International Settings section of your 
Windows Control Panel. For information on Windows time and date 
formats refer to your Windows documentation or on-line Help. 

 

Λ 
Λ 

Λ 
Λ 
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Changing the Default Directories 
At installation, SP creates two subdirectories or folders in which it stores data 
files. Files downloaded from the logger are stored in C:\SP\DATA. Data files 
you export in Lotus.WK1 format are stored in C:\SP\EXPORT. SP allows you 
to change one or both of these default directories. 
1. Click Directories in the Set-up menu. SP displays the Data File Directory 

Selection dialog box. 

 

2. To change the directory in which data files are stored, type the new path 
in the Data File Directory text box. To change the directory in which 
export files are stored, type the new path in the Export File Directory 
text box. 

3. Click OK to confirm the change and close the Data File Directory 
Selection dialog box.  

 

Setting the Logging Parameters 
 

NOTE: Changing the parameters erases the logger’s memory and 
starts a new survey.  Download any data before changing 
parameters. 

Data Storage Interval and Survey Length 
SP Max has the flexibility to store sampled data at intervals from 1 second to 
15 minutes. Because a shorter data storage interval results in the logger's 
memory becoming full more quickly, you can choose to store values 
frequently over a relatively short period or less frequently over a longer 
survey. Alternatively, you may wish to log data over a specified period of time. 
SP PowerPack lets you select a survey duration of between 5.4 hours and 

Λ 
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202.1 days depending on channel set-up and the logger automatically adjusts 
its data storage interval to accommodate the survey length you choose. 
Wraparound Mode 
SP Max has 512 kb of non-volatile RAM. You can instruct the logger to 
respond in one of the following two ways when its memory is full: 

• stop recording and enter Sleep mode to conserve energy, or 
• continue recording and 'wrap around' to replace the oldest data with 

new data. 
Channel Configuration 
SP Max has 6 data input channels; 1 voltage channel, 3 current channels 1 
pulse channel and 1 computed power factor channel. You can log data on all 
6 channels simultaneously or disable some channels. When a channel is 
disabled, the memory allocated to it is reassigned to the active channel or 
channels, allowing you to record longer surveys. Voltage is logged via the 
unit's line power input. For current logging you must identify for the software 
the type of clamp you are using. For pulse meter logging you need to identify 
the type of sensor. You will also need to set current and voltage limits for out-
of-range event detection. In addition, you can select whether the logger stores 
the minimum and maximum values recorded during a storage interval, the 
average of all values recorded, or both. 
 
Storing Minimum, Maximum and Average Values 
SP Max samples data multiple times during each storage interval. You can 
specify whether the logger stores the lowest and the highest readings 
collected during the storage interval (Min/Max), an average of all readings 
collected during the interval, or both.  

NOTE: The SP MAX must be set up to include average values if 
power and energy calculation is required.  I.e. to obtain kVA, kW or 
kWh values ensure that the ‘average’ box is checked in the ‘Change 
Parameters’ window. 

Specifying the Type of Current Transformer in Use 
Before logging current you will need to specify for the software which type of 
clamp you are using. You do this by selecting the range for which the clamp is 
rated.  The default value is 1000A, which is correct for the CTs supplied in the 
standard kit. 
Specifying the Sensor Type for Pulse Meter Logging 
Before beginning a pulse meter survey you will need to specify for the 
software the type of sensor you are using. You do this by selecting an option 
from the list. For instructions on adding different types of pulse meters to the 
list, refer to Appendix D. 

Λ 
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1. To specify the type of pulse sensor in use, click the Sensor button to 
open the Sensor Type Selection dialog box.. 

 
 
2. Open the Pulse drop-down list and select the appropriate sensor type. 

Then click OK. 
 
Setting Current and Voltage Limits for Event Detection 
Indicators on the front of the logger indicate if current or voltage outside a 
specified range has been detected during a survey. This event detection flags 
the need for further analysis of the logged data. SP Max allows you to specify 
the anticipated range for both current and voltage. If SP Max  detects any 
readings outside this specified range, the appropriate led is activated. 

1. Click Change Parameters in the Logger menu. SP PowerPack 
communicates with the logger and displays the Change Logger 
Parameters dialog box. 

 
2. To adjust the Survey Length and Storage Interval move the slider. 
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3. To instruct the logger to replace the oldest data with new data, select 
Wraparound Mode (Continuous). 

 
To instruct the logger to stop recording and enter Sleep mode when its 
memory is full, deselect Wraparound Mode. 
 

4. To enable data logging on any channel, select it. 
To disable a channel, deselect it. 

 
 

NOTE: Pulse logging is disabled if the SP Max is running on battery 
power.  Ensure a mains cable is connected if pulse logging is 
required. 

5. To enable storage of the lowest and highest recorded values select 
Min/Max. 
To enable storage of the average value select Average. 
To disable the storage of either measurement, deselect that 
measurement. 

Current channels enabled 

Pulse channel enabled 

Voltage channel enabled 

Power factor calculation enabled 

Maximum interval 
15 minutes 

Λ 
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NOTE: If the SP Max is being used to measure power or energy (eg 
kW, kWh etc).  It is essential to check all boxes except ‘Pulse’.  
Power and Energy cannot be calculated unless at least one current 
(I) the Voltage (V) and the ‘ Average’ boxes are checked. 

6. To specify the type of current transformer in use, click the Range button 
to open the CT Ratio Selection dialog box. 

 

7. Open the CT drop-down list and select the appropriate CT value. Then 
click OK. 

NOTE:  SP Max logs voltage through the unit's power cable and the 
voltage range cannot be changed. 

 
8. To set the anticipated current and/or voltage range, click the Limits 

button to open the Over/Under Parameters - Logger dialog box. 

Both Min/Max and 
Average enabled 

Λ 
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9. Move the sliders to adjust the upper and lower limits for current or the 
setpoint and tolerance for voltage. Then click OK. 

10. Click Update. SP displays a warning that changing logging parameters 
erases the logger's memory. If you have logged data that you wish to 
save, click Cancel and turn to Downloading Data. Otherwise, proceed. 

 
NOTE: Do not set the Under Current limit to zero.  This will 
disable the unit’s ability to detect CT orientation and phase 
position. 

 
11. Click OK. SP PowerPack communicates with the logger, updates the 

parameters and displays a confirmation message. 

 

Λ 
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12. Click OK. 
 

Downloading Data 
Once your survey is finished, you will need to download the data from the 
logger to your PC. Note that downloading does not clear the data from the 
logger. You can download the same data again, provided that you have not 
cleared the logger's memory by resetting, changing the logging parameters or 
using the Set Time and Date function. 
1. Open the logger's front cover. Plug the download cable into the 9 pin 

connector on the logger. Plug the other end of the cable into the correct 
COM port on the back of the PC. 

2. Click Download SP Data in the Logger menu. SP PowerPack displays a 
progress bar while it downloads the data and a confirmation message 
when the download is complete. 

3. Click OK. SP displays the Ratio/Power Selection dialog box to allow you 
to change the current range scaling for each channel or to set-up the 
power calculation. You can make your selections now, or return to the 
Ratio/Power Selection dialog box after the file has been saved.  

4. Click OK. SP PowerPack displays the Survey File Summary dialog box. 
This dialog box allows you to name the survey, add descriptive notes, 
view the minimum and maximum reading for the survey period, or open 
the Range/Power Selection dialog box. 
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5. To name the survey, click in the Survey Name text box and type in a file 
name. 

6. To add comments or a description, click in the Notes text box and type 
your comments. This information will appear on the Report Summary 
printout. 

7. To view minimum and maximum readings during the survey period, click 
the Min/Max button. SP PowerPack opens the Data Min/Max Values 
dialog box to display the minimum and maximum values for the selected 
display group.  

8. Click OK to close the Data Min/Max Values dialog box. 

9. Click OK on the Survey File Summary dialog box. SP PowerPack opens 
the Windows Save As dialog box. 

 

Survey 
information

Add notes 
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10. Click in the File name text box and name the file. 

File names may be no more than 8 characters long and cannot include 
spaces. You may use any letter or number or any of the following characters 
in file names: underscore (-), caret (^), dollar sign ($), tilde (~), exclamation 
point (!), number sign (#), percent sign (%), ampersand (&), hyphen (-), 
braces ({}), parentheses(),at sign (@), apostrophe (') or the grave accent (`). 

11. Click OK to close the dialog box and save the file. 
 

Calculating Power 
When the Power Factor, Voltage and first Current channels are enabled, SP 
Max logs the phase angle between the Voltage and the Channel 1 current. 
SP PowerPack can use this data to develop the Power Factor and calculate 
kW and kWh values. 
Alternatively, you can choose to log only Current or Current and Voltage and 
then specify a Power Factor in the software. In this case, SP PowerPack 
uses the logged data and the specified Power Factor to calculate kW and 
kWh values. 
It is important to set up the logger correctly to generate reliable power data. 
After completing the survey and downloading the data, you will need to 
specify the Power Set-up using the Ratio/Power Selection dialog box. 
Displaying Power Data 
1. Download the data and save the file.  
2. Click Range/Power in the Set-up menu to open the Ratio/Power 

Selection dialog box. 

 

3. If you need to change the current clamp specified, open the CT drop-
down list in the Channel Ratio pane and select the range. 
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4. Open the Supply Type drop-down list in the Power Set-up pane. 

  

NOTE: Single phase (IP2W) will only appear as an option if the survey was 
carried out with one current channel enabled.  Options vary according to the 
set up used for the actual data logging itself. 

 

5. Select the type of power distribution system logged during the survey 
from the Supply Type drop-down list. Supply type menu structure is as 
follows: 
IP2W (1 x I) = Single phase current only logged 
IP2W (1 x I + V) = Single phase current and voltage logged 
3P3W (3 x I) = 3 phase current only logged on delta system 
3P3W (3 x I + V) = 3 phase current and voltage logged on delta system 
3P4W (3 x I) = 3 phase current only logged on star system 
3P4W (3 x I + V) = 3 phase current and voltage logged on star system 
 
It is possible that other combinations may be available depending on the 
logger set up at the time the survey was carried out. 

 
 
 
 

6. If you logged the Power Factor, select Logger PF Data in the Load Type 
drop-down list.   If Power Factor was not logged, select the correct option, 
or enter a known PF value. 

A 3 Phase, 4 wire system; power 
calculated using 3 measured currents 

and measured voltage. 

Λ 
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7. If voltage was not logged, the Source window in the voltage box will show 
‘Fixed’.  A value must therefore be entered into the Range window.  For 
UK systems a P-N (phase to neutral) value of 240V or a P-P value of 
415V should be selected.  Any desired value can be entered, and is used 
by the software to calculate derived power and energy readings in the 
absence of any measured voltage data.  If voltage was logged, the 
Source window will show ‘V’ indicating the measured values of voltage 
are available.  In this instance the value showing in the Range window 
has no effect. 

8. If you did not log Voltage, but selected a fixed Voltage Value and wish to 
apply a multiplier to the data, open the PT Ratio drop-down list in the 
Voltage pane and select a factor. 

9. If you wish to apply a multiplier to the Current data, open the External CT 
drop-down list in the Current pane and select a factor. 

10. Click OK to close the Ratio/Power Selection dialog box. 

11. Click Measurement Scale in the Set-up menu to open the Measurement 
Scale Selection dialog box. 

 

12. Select kVA, kW or kWh to display the power data. Note that total kWh 
data is displayed as 30 minute bar graphs rather than line graphs.  
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NOTE: Unless the relevant data has been entered into the power 
selection set-up window, the Measurement Scale Selection 
options will be limited to Raw Data and Primary Parameters only. 

For details on SP PowerPack's power calculations, refer to Appendix C. Note 
that after the power data has been calculated, you can enable SP 
PowerPack's Costing feature. 

 
Viewing the Data 
SP PowerPack allows you to view logged data in a variety of different ways. 
You can select which channel or channels you would like to display. You can 
view the data as a graph or in tabular form. You can display summary 
information about the survey, and you can zoom in for a more detailed view of 
the data relative to the graph's Y axis.  
Selecting a Display Group 
SP Max can log minimum, maximum and average readings on 6 separate 
input channels. To display this volume of data most clearly, SP PowerPack 
organises it into subsets. The software allows you to select a display group 
which is defined as a single channel or a group of related channels. The 
display group you select automatically sets the following display parameters: 
• which data appears in graphs 
• which units of measurement appear on graphs 
• which data appears in tabular data lists 
• which units of measurement appear in the Logger Status dialog box 
• which minimum and maximum data values appear in the Data Min/Max 

Values dialog box 
• which trace selections appear in the Display/Print Options dialog box. 
Where possible, the last selected display group becomes the default when 
you open or download a new file. If SP PowerPack does not display you data 
or does not display the channel you wish to see, you may need to select a 
different display group. 

Λ 
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1. Click Measurement Scale in the Set-up menu to open the Measurement 

Scale Selection dialog box. Note that kVA, kW and kWh appear in the list 
only after you specify a Supply Type in the Ratio/Power Selection dialog 
box.  

 

2. Select a display group to specify the information you would like to display. 

3. Click OK to close the Measurement Scale Selection dialog box. 
 
Viewing the Data as a Listing 
1. Click Measurement List in the View menu. SP displays the data in 

tabular form. Depending upon the display group you have selected, the 
table will include different information, however the item number, date and 
time of each sample is always shown. 

 

 
 
Viewing the Data as a Graph 
1. Click Measurement Graph in the View menu. SP displays the data as a 

graph. Depending upon the display group you group you have selected, 
the graph will include different information and display different units of 
measurement. 
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Displaying the Survey Summary Information 
You can check the summary information for any survey quickly and easily. 
1. Click Survey Summary on the View menu OR click Survey Description 

in the Set-up menu. SP PowerPack displays the Survey File Summary 
dialog box. 

 
 
2. To display the minimum and maximum readings during the survey period 

for the display group you have selected, click the Min/Max: button. The 

Survey 
information 
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minimum and maximum values are displayed in the format shown below. 
To close the Data Min/Max Values dialog box, click OK. 

 
 
 

 
 
 
 
 
3. To examine the current range scaling for each channel or set-up the 

power calculation, click the Range: button. To close the Ratio/Power 
Selection dialog box, click OK.  

4. Click OK to close the Survey File Summary dialog box. 
 
Zooming In and Out 
SP PowerPack allows you to zoom in on a graph for a more detailed view of 
the data relative to the Y axis. The software automatically selects the closest 
zoom that still allows the minimum and maximum graphed values to be 
displayed. Then you can zoom out to return to the overview.  
 
1. Click Zoom on the View menu. SP PowerPack displays a magnified view 

of the graphed data. 
2. Click Unzoom on the View menu. SP PowerPack displays the overview 

of the graphed data. 
 

Displaying and Printing Graphed Data 
SP PowerPack gives you control over how your data is displayed, graphed 
and printed. You can choose which traces, channel or channels to include in a 
graph, select the length of time displayed or printed on a graph, and add a 
title, other text or your company logo to the summary page of all your printed 
reports. 
 

Channel

Value 

Date 

Time 
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Selecting Which Data to Graph 
Although SP Max can log minimum, maximum and average data on all 6 
channels simultaneously, you may prefer not to display or print all logged 
traces. SP PowerPack lets you choose to display or print a single trace or a 
combination of traces. 
Changing the X Axis Time Period 
SP PowerPack allows you to select the period of time included on a single 
displayed or printed graph. You change the time period by adjusting the 
graph's X axis. 
 

1. Click Display/Print Options in the Set-up menu to open the Display/Print 
Options dialog box. The channels displayed in the Trace Selections pane 
change depending upon which display group you have selected.                

 
2. To display or print a specific trace, select it. 

To prevent a trace from displaying or printing, deselect it.  
To display or print all logged traces, click the All On button. 

 
3. Click to select an alternate time period in the Graph, Print List Length 

pane. The selection you make here also determines the minimum time 
period that can be printed in a graph or list. 

Select or deselect logged 
traces to display or print 

Select time period 
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4. Click OK to close the Display/Print Options dialog box. 
 
Adding a Text Header and Logo to the Summary Page 
SP PowerPack allows you to add a title, slogan or other text as a header on 
the Summary Page of all your graphs and reports. You can include a bitmap 
of your company logo so that it prints as well on the Summary Page. 

1. Click Header in the Set-up menu to open the Header Set-up dialog box. 

 

2. Select Summary Page in the Use Header For pane. Note that the 
Statistics Printout feature is unavailable for SP Max. 

3. Click to place the insertion point in the upper text box labelled Header 
Text Lines. Note that there are 2 text boxes, allowing for 2 lines of text in 
the header. 

The time period assigned to 
the X axis of the Measurement 

Graph is 7 days. 
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4. Type in the text. If you wish to add a second line of header text, press 

Tab OR click to place the insertion point in the lower text box and then 
type in the text. 

 

5. Select Include in the Logo Bit Map pane. 
6. Click File in the Logo Bit Map pane to open the Select Summary Logo 

Bitmap File dialog box and specify the location of the bitmap. You will find 
a sample file named Elc.bmp in the spk directory or folder. 

 

7. Select the bitmap you would like to include. If you do not have a bitmap of 
your logo, but would like to test this feature, you can use the sample 
Elcomponent log, Elc.bmp. 

8. Click OK. SP PowerPack displays the location of the logo bitmap beside 
the File button in the Header Set-up dialog box. 

 
9. Click OK to close the Header Set-up dialog box. 
 
Printing a Graph and Summary Page 
With SP PowerPack you can choose to print all the data for a survey or only 
those readings that occurred during a specific time period. You can enable or 
disable printing of the Summary Page or specify the print quality of the graph 
or listing. You can also open a Print Set-up dialog box to select the page 
orientation or access other print set-up functions. 
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1. Make sure that the graph or list you wish to print is open and that  the 
data is displayed as you would like to see it printed. 

2. Click Print in the File menu to open SP PowerPack's Print dialog box. 

 
3. To print all the data for a survey, select All in the Print Range pane. 

To print only those readings that occurred during a specific time period, 
select Dates in the Print Range pane and then move the sliders to 
specify the time period. 

The minimum Print Range you can select depends on the Graph Print List 
Length you selected in the Display/Print Options dialog box. For example, if 
you selected a Graph Print List Length of 2 days, the minimum Print Range 
will also be 2 days. 
 

4. To enable printing of the Summary Page, select Print Summary Page. 
To disable printing of the Summary Page, deselect Print Summary Page. 

5. To change the print quality, open the Print Quality drop-down list and 
select an alternative dpi rate. 

6. To change the page orientation click the Set-up button to open the Print 
Set-up dialog box and select Portrait or Landscape. 

7. Make any other changes to the Print Set-up you would like, and then click 
OK to close the Print Set-up dialog box. 

8. Click OK on the Print dialog box to close the dialog box and print the 
selected information. 

Costing 
SP PowerPack allows you to calculate the basic cost of the energy power 
you use and the software supports both peak (Day Rate) and off-peak (Night 
Rate) rate structures. To set-up the Costing feature, simply specify the time of 
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the peak billing period. SP PowerPack automatically applies the off-peak rate 
to the remainder of the day. Then input the cost per kWh for the peak billing 
period and for the off-peak period if that applies. The software stores this set-
up information. 
To calculate and display the cost of your power consumption, enable the 
feature while displaying your kWh data as a graph or list. 
Set-up Costing Information 
1. Click Costing in the Set-up menu to open the Costing Set-up dialog box. 

When costing is disabled, both panes in the dialog box are dimmed. 
2. Select Costing Enabled to turn the feature on and to activate the Day 

Rate and Night Rate panes in the dialog box. If None has been selected 
as the Active Period in either pane, the Active Period in the other pane 
will be Entire Day. 

 
 

3. If the Active Period in the Day Rate pane is None, move the Period 
Length slider slightly so that SP PowerPack displays an actual time 
period. 
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4. To set-up a day rate and a night rate, move the Period Start slider to 
specify the start of the peak billing period. The Active Period in the Night 
Rate pane adjusts automatically. 

5. Move the Period Length slider to specify the end of the peak billing 
period. The Active Period in the Night Rate pane adjusts automatically. 

 

 

6. To set-up a single billing rate, move the Period Length slider to the far 
right so that the Active Period displays Entire Day. The Active Period for 
the Night rate will display None. 

7. Double click in the Cost per kWh box in the Day Rate pane to highlight 
the number displayed and then enter the appropriate rate. 

Active Period displayed

Adjust Active Period

Night Rate adjusts 
automatically 
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NOTE: The units of currency displayed are determined by 
Windows. To change the units of currency, refer to the 
International Settings information in your Windows 
documentation or on-line Help. 

8. To add an off-peak rate, adjust the sliders to specify two separate billing 
periods. Then double click in the Cost per kWh box in the Night Rate 
pane and enter the appropriate cost. 

9. Click OK to make the changes and close the Costing Set-up dialog box. 

 
Displaying Costing Information 

Costing information displays only on kWh graphs or lists. To view your 
consumption costs you need to select the kWh display group in the 
Measurement Scale Selection dialog box.  

 

Pulse Meter Logging 
SP Max allows you to log data from almost any kind of pulse meter. You can 
modify one of SP PowerPack's initialisation files to add details about the 
sensors you intend to use, the unit of measurement per pulse, and the 
calculations associated with a variety of pulse metering applications. Once 
you have set up the specific pulse information in the SPMax.INI file, SP 
PowerPack will calculate consumption values based on your input. For 
instructions on editing SPMax.INI, refer to Appendix D. 
Pulse logging differs from other kinds of logging in that SP Max counts and 
stores all pulses it receives. The Min/Max and Average modes of data storage 
do not apply.  To complete a pulse meter survey, the logger must be 
connected to line power.  If it is running on battery, pulse data will not be 
stored.  

   
Displaying Pulse Meter Data 
You can display Pulse Meter data as either a simple flow or as a consumption 
rate. To calculate and display a consumption rate, you need to specify the 
time period to be used in the calculation and select Pulse Rate as the display 
group. 
1. Download the data and save the file.  
2. Click Pulse Rate Period in the Set-up menu to open the Pulse Rate 

Selection dialog box. 

Λ 
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3. Select the period for which you would like the consumption rate calculated 

and displayed 

4. Click Measurement Scale in the Set-up menu to open the Measurement 
Scale Selection dialog box. 

 

5. To display the measured pulses as a line graph, select Pulse. 
 
To display a consumption rate as a bar graph, select Pulse Rate. 

 

Logger Status 
Checking Logger Status 
SP PowerPack allows you to check the status of the logger. The Logger 
Status dialog box displays the type of logger in use, the logging parameters 
selected, and the present readings for each enabled channel. 
1. Make sure that the logger is connected to the PC. 
2. Click Read Status in the Logger menu. SP PowerPack communicates 

with the logger and displays the Logger Status dialog box. 
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3. Click OK to close the Logger Status dialog box. 
Resetting the Logger 
Resetting the Logger erases the unit's memory and begins a new survey, so 
be sure to download any data before resetting the unit. You should reset after 
transporting the logger to the survey site and connecting it to the circuit or 
equipment you are monitoring.  
1. To reset the logger in the field, press the recessed RESET button on the 

unit's front panel.  
Should the RESET button fail or if you wish to clear the logger's memory and 
restart a survey while the unit is connected to your PC, you may reset SP 
Max using SP PowerPack software. 
1. Click Reset in the Logger menu. SP PowerPack communicates with the 

logger and then displays a warning message. 
2. Click OK to clear the logger's memory and begin a new survey. 
 

Adjusting the Logger - PC Communication Speed 
SP PowerPack allows you to adjust the speed at which your computer 
communicates with the logger. If you have a Pentium PC, you can select a 
communication speed of 19200 baud. However, if you are using a slower 
computer, you may find you receive incomplete downloads at 19200 baud 
due to data transmission errors. In this case you can select a slower rate of 
9600 baud.  
In addition, the software includes a handshaking control feature. When this 
feature is enabled, your computer can signal the logger to briefly suspend the 
download. When the computer has caught up, it can then signal the logger to 
resume data transmission. Handshaking control should normally be enabled. 
 
1. Click Logger Serial Port in the Set-up menu to open the Logger Port 

Set-up dialog box. 

Channel data is displayed in 
the measurement units you 

selected in the Measurement 
Scale Selection dialog box. 
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2. Select a communication speed click in the MBL Options pane. 

 
3. To enable handshaking control, select XON/XOFF in the MBL Options 

pane. 
4. Click OK to adjust the communication speed and close the Logger Port 

Set-up dialog box. 
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When Things Go Wrong 
If you have difficulty with your SP Max logger or SP PowerPack software, 
consult the following list of solutions. If you still have trouble, please call us at 
Elcomponent Ltd or email us at: sales@elcomponet.co.uk. 
 
Menus and Dialog Boxes 
There are menu and dialog box items in SP PowerPack that are always 
dim and unavailable. 
Elcomponent Ltd. offers a broad range of logging and metering equipment, all 
supported by SP PowerPack. Some selections in the software relate to 
features not supported by the SP Max logger.  
Please contact us for details of other SP Loggers. 
 
Download Problems 
The SP Max will not download. 
• Check the download cable and make sure it is plugged into the correct 

communications port on your computer. 
• Make sure you have selected the correct COM port in the Set-up section 

of the software. Refer to Setting Up Silent Partner PowerPack 
Software for instructions. 

• If you are downloading at 19200 baud, try setting the communication 
speed down to 9600 baud. Refer to Adjusting the Logger - PC 
Communication Speed for instructions. 

• Toggle the XON/XOFF handshaking control.  
• If you are using a laptop computer, problems may be encountered due to 

the very low voltage swing on some portable PC serial ports.  Check 
download performance on a desktop PC to verify if this is an issue. 

When accessing Silent Partner Series loggers,  the SP POWER Software 
sends a query to the logger which in turn generates a specific 
acknowledgement from the logger.  An error message is generated if this 
specific acknowledgement is not received.  Possible causes for this include: 
• The selected comm port is allocated to a modem.  Verify by running 

Terminal or Hyperterminal.  Any response from the port to an 'AT' 
command (with the logger disconnected) indicates a problem. 

• If the first test does not indicate a problem, the possibility remains that 
another peripheral (most often a network card) is using the same IRQ as 
the comm port.  Other devices may function correctly because they rely 
on means other than the IRQ for data validation.  SP POWER uses 
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Windows API function calls and will not work if an IRQ conflict exists on 
the port. 

• A similar situation exists if the port is sharing the same hardware address 
as another device. 

• Older PCs using early version UART chips (notably 8250 or 8251) may 
not have sufficient resources to receive high speed data properly if X 
On/X Off is disabled.  The same problems can be generated if processor 
speed is set too slow. 

• Some PCs, especially those running windows 3.1 may have third party 
comms drivers installed.  These may cause problems with software 
designed to run with standard Windows drivers. 

• In addition to the above it is possible that shortage of RAM will cause an 
invalid logger response although this is highly unlikely if other programs 
are functioning correctly. 

 
• If problems are experienced with running SP PowerPack Software it is 

recommended that a test be made on a stand-alone PC running Windows 
95/98 if possible, as a control reference prior to troubleshooting as 
detailed above.  Because W95/98 is more sophisticated in the way it 
deals with both hardware and software installations, conflicts are less 
likely than in earlier versions. 

 
The software reports an “Invalid Wakeup Response”, or “Scan Ports for 
Logger” says that no logger was found. 
• Make sure the download cable is plugged in before pressing the scan 

button. 
• If you have unplugged a serial mouse and then plugged the logger into 

that port, it probably will not work. The reason for this is that the Windows 
mouse driver will report that the port is still in use by the mouse, 
regardless of whether or not it is physically connected. If this happens, 
Windows will not allow SP to use that port for communications. This can 
be overcome by using a different port for communication with the logger. 
Refer to Setting Up SP PowerPack Software for instructions. 

• Ensure that the port you are using actually works. You can do this by 
attempting to communicate with some other device such as an external 
modem. 

 
Time and Date 
The time and date on all of the graphs and printouts is wrong. 
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• Make sure you have set the logger's clock using the Set Time and Date 
function in the software. Refer to Synchronising Logger Time and Date 
with the PC for instructions. 

• Ensure that your computer's time and date are set correctly. 
• Make sure that you press the RESET button on the logger to begin each 

survey. 
 
All of the times on the graphs and reports are in 24-hour format, but I 
want 12-hour format (or the reverse).  
The dates appear in the wrong format. 
The way in which times and dates are displayed in the SP software is 
determined by the International Settings portion of Control Panel in Windows. 
For information on changing the International Settings, refer to your Windows 
documentation on on-line Help. 
 
Printing 
I click on the Cancel button when printing, but the printer keeps on 
going. 
Printing can continue after you click the Cancel button for several reasons. 
Windows has a feature called Print Manager which acts as a background print 
spooler. The function of a print spooler is to allow printing in the background, 
freeing up your computer for more important things. If Print Manager is 
enabled, SP PowerPack prints to Print Manager instead of to the printer. 
Print Manager, in turn, sends the data to the printer leaving the computer free 
for other tasks. Pressing Cancel stops data from going to Print Manager, but it 
will not stop Print Manager from sending the data it already received to the 
printer.  
 
To remedy this situation, cancel the print job from Print Manager. 
• Select the proper print job from the list and delete it. 
• You may wish to disable Print Manager and print directly to the printer. 

For information on disabling Print Manager, refer to your Windows 
documentation or on-line Help. 

 

Your printer may also continue to print if it has a large amount of on-board 
memory. This memory serves the same purpose as Printer Manager by 
providing a temporary storage space for the data to be printed so that the 
computer can move on to more important tasks.  
• If Print Manager is disabled and your printer continues to print after you 

click Cancel, reset your printer. This should clear any data stored in the 
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printer's memory. If your printer does not have a reset switch, turn the 
printer off and then on again. 

 
Display 
The colours on the Graph are difficult to see on the screen. 
Refer to Appendix A for information on changing SP PowerPack’s graph 
colours. 
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Appendix A - SILPRTNR.INI File Settings 
SP PowerPack stores some of its configuration information in a special file 
called SILPRTNR.INI. You can edit this file using Notepad or any other text 
editor. 
 
 NOTE: This file should only be modified by advanced users. 

Customising Graph Colours 
If the colours used in the measurement graph are not to your liking, you can 
change them by editing items in the “[GraphPref]” section of the 
SILPRTNR.INI file shown below. 
[GraphPref] 
 
Meas1RGB=255,0,0    ;Channel 1 (I1) Avg 
Meas2RGB=0,255,0    ;Channel 2 (I2) Avg 
Meas3RGB=0,0,255    ;Channel 3 (I3) Avg 
Meas20RGB=128,0,0   ;Channel 4 (V)  Avg 
Meas21RGB=0,128,0   ;Channel 5 (PF) Avg 
Meas22RGB=0,0,128   ;Channel 6 (Pulse) 
Meas4RGB=255,0,0    ;Channel 1 Min 
Meas5RGB=255,0,0    ;Channel 1 Max 
Meas6RGB=0,255,0    ;Channel 2 Min 
Meas7RGB=0,255,0    ;Channel 2 Max 
Meas8RGB=0,0,255    ;Channel 3 Min 
Meas9RGB=0,0,255    ;Channel 3 Max 
Meas10RGB=128,0,0   ;Channel 4 Min 
Meas11RGB=128,0,0   ;Channel 4 Max 
Meas12RGB=0,128,0   ;Channel 5 Min 
Meas13RGB=0,128,0   ;Channel 5 Max 
TotalRGB=128,0,128  ;Calculated Total (kWh) 
GridRGB=127,127,127 ;Graph Grid 

 
The items that control the colours are named from Meas1RGB= to 
Meas22RGB=, TotalRGB= and GridRGB= as shown below. The three 
numbers separated by commas after each of these names determine the 
colour for that item by specifying the amount of Red, Green and Blue 
‘pigments’ used, with the value of each pigment ranging between 0 and 255. 
Some sample colours are listed below. You can also experiment with the 

Λ 
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colour palette in the Windows Paint program to determine the RGB values for 
other colours: 

Colour Red Green Blue 
Black 0 0 0

Blue 0 0 128

Green 0 128 0

Cyan 0 128 128

Red 128 0 0

Magenta 128 0 128

Brown 128 128 0

Light Grey 128 128 128

Dark Grey 192 192 192

Light Blue 0 0 255

Light Green 0 255 0

Light Cyan 0 255 255

Light Red 255 0 0

Light Magenta 255 0 255

Yellow 255 255 0
 
If you will be printing graphs on a black and white printer, be aware when 
choosing alternative colours that shades for which the sum of the Red, Green 
and Blue values is less than 382 will be printed as black, whereas colours for 
which the sum is greater than 381 will be printed as white. 
 
Other SILPRTNR.INI Items 
The remaining items in the SILPRTNR.INI file reflect various options that are 
selected while using the software and are changed while running SP Power 
Pack. 
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Appendix B - SPPOWER.INI File Settings 
 NOTE: The following section is intended for advanced users. 
Customising SP Power Calculations 
Editing the SPPOWER.INI file allows you to set some of the computational 
parameters for the Power feature of the software. SP PowerPack refers to 
SPPOWER.INI for the options it displays in the Ratio/Power dialog box's drop-
down lists. You can edit these entries to add custom line voltages, fixed 
power factors, etc.  
If you open SPPOWER.INI in Windows Notepad or a similar text editor, the 
file will resemble the sample shown on the following page. 
 

NOTE: Changes to the SP POWER.INI file should be undertaken with 
caution, since incorrect entries could cause erroneous calculations. 

;SP Power Value File 

[Defaults] 

V1Phase=110, 120, 220, 240, 347 

V3Phase= 208, 380, 415, 600 

HVRatio=11kV:110, 11kV:240, 1000:110 

LoadType=Office 0.9, Factory 0.85, Refrigeration 0.8, Heating 
1.00, Lighting 1.00, Motor 0.80 

ExtCT=100:5, 200:5, 300:5 

kWhPeriod=15 

V1Phase= Lists the voltages that appear in the Voltage 
Range box for single phase supply types. 

V3Phase=  Lists the voltages that appear in the Voltage 
Range box for three phase supply types. 

HVRatio= Lists the PT ratios that appear in the PT Ratio 
box. Each entry is in the format <primary voltage>:<secondary 
voltage>. A comma separates individual entries. 

LoadType= Lists the pre-defined Power Factor values that 
appear in the Load Type (PF) box. Each entry is in the format 
of <description> <space> <Power Factor value> 

ExtCT= Lists the CT ratios that appear in the External CT box.  
Each entry is in the format <primary voltage>:<secondary 
voltage>>. A comma separates individual entries. 

kWhPeriod= Defines the calculation period in minutes used 
when computing kWh. This value is set to 15 in North America, 
30 for Europe. 

Λ 

Λ 
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Appendix C – Power Configurations and Calculations 
 
NOTE: You must enable Average recording in the Logger Set-up 
section in order to calculate power.  If you record only Min/Max 
information, you will not be able to access the Ratio/Power Selection 
dialog box. 

 
Over/Under Current Detection in the Logger 
An undercurrent condition is detected in the logger when: 

I1 channel current < configured Undercurrent Limit. 
An overcurrent condition is detected in the logger when: 

I1, or I2, or I3 current > configured Overcurrent Limit. 
 
 
Over/Under Voltage Detection in the Logger 
An undervoltage condition is detected in the logger when: 

Line Voltage < configured Setpoint Voltage - Tolerance. 
An overvoltage condition is detected in the logger when: 

Line Voltage > configured Setpoint Voltage + Tolerance 
 
 
Average Calculations 
When you enable the Average data storage mode, the value SP PowerPack 
stores is calculated based on the following numbers of samples per storage 
interval. 

Λ 
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Storage 
Interval 

Samples/ 
Average 

Storage 
Interval 

Samples/ 
Average 

1 second 4 2 minutes 480 

2 seconds 8 3 minutes 720 

3 seconds 12 4 minutes 960 

4 seconds 16 5 minutes 1200 

5 seconds 20 6 minutes 1440 

6 seconds 24 7 minutes 1680 

7 seconds 28 8 minutes 1920 

8 seconds 32 9 minutes 2160 

9 seconds 36 10 minutes 2400 

10 seconds 40 11 minutes 2640 

20 seconds 80 12 minutes 2880 

30 seconds 120 13 minutes 3120 

40 seconds 160 14 minutes 3360 

50 seconds 200 15 minutes 3600 

1 minute 240   
 
Current and Voltage Combinations for Calculating Power 
SP PowerPack is very intelligent and can generally determine the appropriate 
metering systems depending on the way in which the logger has been 
configured. The chart below explains how to configure your logger depending 
on the voltage distribution system you wish to monitor. 
 
Supply Type  Required Logger Configuration 
1P2W 1 Current or Voltage, Current I1and Power 

Factor  
1P3W 2 Currents or Voltage, Current I1, Power Factor 

plus Current I2 or I3 
3P3W 1 Current or 3 Currents or Voltage, Power 

Factor and either Current I1 or 3 Currents 
3P4W 1 Current or 3 Currents or Voltage, Power 

Factor and either Current I1 or 3 Currents 
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Note that the logger measures Power Factor by determining the phase angle 
between the Voltage and the Current 1 (I1) channel input signals. If the 
Voltage and I1 Current channels are not both logged a fixed Power Factor 
can be selected for use in the power calculations instead of that measured by 
the logger. 
SP PowerPack Power Calculations 
SP PowerPack calculates power values for each channel as shown below: 
Supply Type Channel Power 
1P2W 
1P3W 
3P4W 

 
  VPHASE-NEUTRAL x I x PF 

3P3W   VPHASE-PHASE x I x PF 

 3  

 
In all cases, Total Power is the sum of the power for all phases. The total for a 
multiple supply type for which only 1 Current is measured is calculated 
assuming a balanced load and is the power in the measured circuit multiplied 
by the number of phases of the supply. 
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Appendix D - SPMax.INI File Settings  
(CT Ratios and Pulse Channel Configurations) 
 
 NOTE: The following section is intended for advances users. 
SP PowerPack allows you to specify the CT and PT ratios and the pulse 
meter types which are available within the software for logger configuration. 
You do this by editing the SPMax.INI file. If you open SPMax.INI in Windows 
Notepad or a similar text editor, the file will resemble the sample shown 
below. 
;SPMax.ini file 
 
[Current] ;CT Ratios for I1-I3 Channels 
Ratio= 5, 10, 20, 50, 100 
 
[Voltage] ;PT Ratios for Line Input Voltage Channel 
Ratio= 240 
 
[Pulse] ;Meter types and units 
;Type Number, Name, Pulses per unit, Unit of measure, 
Unit abbreviation, Rate Type 
Type01=Water, 1000, Litres,l 
Type02=PCount, 1, Counts, c 
Type03=W Demand, 0.001, W, W, HourRate 

 
[Current] Group 
In the “Ratio=” item, list the current clamp types that you would like to appear 
in the Configuration/Range CT list. Multiple items in the list are separated by a 
comma. 
 
[Voltage] Group 
In the “Ratio=” item, list the line voltages that you would like to appear in the 
Configuration/Range PT list. Multiple items in the list are separated by a 
comma. 
 
[Pulse] Group 
Each item in this group is used to define the characteristics of a pulse meter 
type which is available for selection from the Configuration/Sensor list. The 

Λ 
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meter descriptions are identified by a type number followed by a list of up to 5 
parameters in the order shown below: 
 
Type Number  
The meter type number at the start of the line is in the form “Typexx=”, where 
xx can range from 01 to 99 to allow up to 99 pulse meter types. The type 
number for the selected pulse meter is stored within the logger during 
configuration updating and is saved along with the survey data after a 
download. When survey data or the logger status is displayed, the configured 
type number is used to select the characteristics of the pulse meter from this 
file. 
 
Name 
This parameter contains the name of the meter which appears in the 
Configuration/Sensor list. The name can be up to 10 letters long. 
 
 
Pulses Per Unit 
This parameter specifies the number of pulses from the meter which 
represent 1 of the measured units and can be up to 6 digits long (including the 
decimal point). Data displayed for the Pulse display group selection are 
scaled by this number as: 

Pulse Count From Logger 
Pulse Value = Pulses Per Unit for configured meter type 
 
For example, the Type01 meter shown in the sample file outputs a pulse for 
every millilitre of liquid measured, so a unit quantity of 1 litre would be 
indicated by 1000 pulses. Conversely, the Type03 W Demand meter outputs 
kW pulses, so each Watt unit is only 1/1000 of a pulse, or 0.001. 
 
Unit of measure 
This parameter specifies the name of the measured units to be used for 
identification with the survey data. The name can be up to 6 letters long. 
  
Unit abbreviation 
This parameter identifies the abbreviation to be used to identify the pulse 
meter data type when displaying the data and can be up to 3 letters long. 
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Rate x Time Calculation 
 
This option is set to y (yes) or n (no) and sets the ‘pulse rate’ option.  If it is 
set to y, pulse rate data will be available, calculated as: 

 Pulse Count  
Sample Interval 

x  30 minutes 

 
Examples: 
 
Type 01 = Water, 1000, Litres, L, n 
 
means that option 1 in the list of available meters will be: 
 

A water meter, with a pulse rate of 1000 pulses per litre, 
where the abbreviation L is used for the unit of measure, and 
there is no calculation of rate x time. 

 
Type 02 = Gas, 0.1, cu.m, m3, y 
 
means that option 2 will be: 
 

A gas meter, with a pulse rate of 0.1 pulses per cubic metre 
(10 cubic metres per pulse) where the abbreviation m3 is 
used for the unit of measure, and the rate x time calculation is 
enabled (yes). 




